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Manage Reports 
 
Report Managers and Viewers can access the Manage Reports screen and the Reporting 
functions therein.  This includes access to all reports listed in the “Local > Report” folder and/or 
included in the various tabbed folders, as shown in the example below. 
 

 
   
Note: 
New LibPAS subscribers will find that their “Report” folder will be empty and Report 
Templates may or may not be offered depending on which Collections the user has authority to 
access. 
 
The tabbed folders enable grouping of reports for ease of navigation and understanding.  Report 
names are links and when selected enable execution and updating of Report settings.   
 
Note:  
Only Report Managers can create/modify/remove reports and create Report Templates or 
Publish reports. 
  
Users with access to other “publicly” accessible data collections (e.g., IMLS, NCES, 
State/Provincial Data Collections, ACRL, PLDS, CULC, etc.) can also access any Report 
Templates created by the respective organizations that own the data collection. If a user’s 
library is also a member of any of these organizations that offer these publicly accessible 
collections, the user will have access to each of the respective organizations folders (e.g., FL 
and PLA, as shown above).  Access to these organization’s folders provides access to the 
report folders shared with the members of that organization, including the Report Templates 
and Published Reports folders of that respective organization. 
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Clicking on the Report name for any report opens the “Report Settings” Screen and displays the 
report selections made for the selected report.  Run the report to generate the output of results 
in the browser window.  Some reports contain additional links to embedded content that enables 
drill-downs to additional details including access to pop-up charts/graphs and download of 
results. Content in chart/graphic format are represented by a graph icon.  Clicking on a graph 
icon (as shown above) will present the chart/graph in a subsequent pop-up window.  
  
Additionally, export/download icons indicate the file format for the information that can be saved 
locally.  Clicking on these links will produce a downloadable file for viewing in the corresponding 
target program (e.g., Excel, Word, etc.). 
  
The Manage Reports screen is essentially an online Reports filing cabinet with folder tabs to 
organize reports and provide access to template reports and previously published reports.  
From here, new reports can be created from scratch.  
 
Report Managers can create new reports. Click “Add” in any “Local” folder or click an existing 
Report Name (or Report Template) in the Manage Reports screen and then update and save 
the new report settings by selecting the [Save as New Report] button. The “Add” report button 
will add the report within the folder open when  you clicked “Add” unless the folder selection is 
changed in the Report Settings during the report’s creation. The Add Folder button, denoted 
by the folder with the plus symbol (+), enables new folders to be added to the Manage Reports 
filing cabinet. As well, an ‘Update folder” button in the selected folder allows the Report 
Manager to Update the Name, Description and Sequence of the folder. 



   

For the Confidential and Exclusive use of Counting Opinions Subscribers 
Page 4 of 33 

 

  
Note: 
Reports can only be added to the Report Template and Published Reports folders by clicking 
the [Save as New Template] or [Publish Report] buttons respectively in the Report Settings 
screen. 
  

Remove Folders 
  
Report Managers have the option to “Remove Folder”.  Only folders that do not contain any 
reports will have the “Remove Folder” option. To remove a folder that has reports included, 
these reports must be moved or removed first. Selecting “Remove Folder” immediately removes 
the folder. 
 

  

Report Multi-Select, Remove and Move 
  
All local report folders now include an option to multi-select all or any number of reports using 
the checkbox associated with each report. Selection of one or more reports reveals the options 
to Remove and Move reports. Multiple selected reports can be moved or removed en masse.  
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The header row also includes a “Check/Uncheck All” checkbox.  Selection of the available 
[Remove] or [Move] buttons triggers the confirmation dialog box(es) to complete the request. 
 
Users assigned the Report Viewer or Report Manager roles can access the LibPAS Manage 
Reports screen.  Reports Managers can create and also remove reports.  Removing a report 
removes any record of the report and its settings.  Only Report Managers have the authority to 
remove reports, but the report to be removed must also be owned by the user’s organization.  
Report Viewers are only able to run existing reports and temporarily change the settings of 
these reports.   
 
Note: 
Report Viewers can only view existing reports and temporarily revise the settings of these 
reports. Report Viewers are  not able to save changes, create new reports and/or remove 
reports. 

Remove 
  

 
  

         Move 
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Column Sorting 
  
The list of reports can be sorted. Select a column header to sort the rows (reports) by the 
content in that column. Selecting the header column again will toggle the sort order between 
ascending and descending. 

  
  

Report Types 
  
The Report Type (Table, Trend, Graph, Cross-Tab, etc.) selected in the Report Settings 
screen for the saved report is displayed in the Report Type column to readily help differentiate 
reports. 

 
 

Report Templates and Published Reports 
 
A Report Manager, if logged in for an organization that owns a Collection, can create report 
templates based on those Collections.  Report templates are automatically added to the Report 
Templates folder.  Template reports are accessible by any LibPAS user that has access to the 
Collection, including users at subordinate levels in the organization (unless other access 
restriction have been applied by the Collection Manager – see Collection Access 
Restrictions). 
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Report Managers can also Publish Reports. Published reports are automatically added to the 
Published Reports folder.  Published reports have a unique URL assigned to them that can be 
used on any website, or distributed by email, for example.  Published reports have the 
advantage that users accessing a Published report do not need to login to use the report, which 
makes sharing your report with a wider audience very easy. 
  

Create a New Report 
To create and set-up a new report, click on the “Add” button, as shown, found in the Local 
report folders at the top and bottom of the selected Local folder.   

 
 
This will open the “Report Settings” screen as shown below.  The report settings screen 
enables the selection of PIs from any available Collection. 
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To begin creating a report, select a Collection from the Collection select list, e.g. Systems 
Report, as shown above. Once a Collection is selected the screen will automatically refresh.  
Selecting a collection confirms the data source, the periods of data available and the PIs 
included in the data collection.  These available PIs will appear in the select list (shown in the 
purple box – Step 4) for the selected Collection. To expedite the selection of PIs and to Add 
these to the Report, you can select a Group name from the Group select list to focus the list of 
PIs on those included in the selected Group.  To add a PI to the report, select the PI by clicking 
on the PI name. The selected PI becomes highlighted. Click “Add” to add the PI to the Report 
Settings. You can also multi-select PIs in the PIs list by holding down the control key 
(command key for Apple users) when selecting PIs.  Click “Add” to add all the selected PIs to 
the Report Settings. The selected PIs will be added in the same sequence order they appear in 
the data collection.  
 

Multi-Collection (Data Source) Reports 
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You can also add PIs from more than one Collection.  To do so, simply select a different 
Collection from the PI select list and add the PIs as appropriate.  
 
Note: 
LibSat subscribers can similarly add Customer Satisfaction data to their reports by selecting and 
adding the questions that relate to captured LibSat customer data. 
  
Any PI added to a Report can be used as a filter, as highlighted below in the red and green 
boxes.  For example, low, high or a low to high range of values can be set to provide filter 
criteria.  The “% Filter Low >=” field can also be used to set a +/- percentage filter range.  By 
setting the Filter Low value to 10% for example, LibPAS will filter values based on comparing 
the value for the current user’s login location, such that all other locations with data values 
within +/-10% of that PI value will be included in the report output. 
 

 
  
If you select the Report Type: Graph/PI, the Report Settings screen provides an additional 
option to add an “Overlay” on any Graph generated for a PI included in the report (see above).  
An overlay presents data from another PI as a line chart superimposed on the bar chart for the 
underlying PI.  This visual “cross-tabulation” can help to convey the relationship between the 
values of two PIs.  To add an overlay, simply click in the appropriate field in the Overlay column 
and then select the desired PI for the Overlay from the PIs in the PI select list offered in the pop-
up window.  In the example above, the PI for the expenditure on “Total Library Materials” 
(EXPLM) has been added as an Overlay to the PIs for “Volumes held” and “Current Serial 
Totals.” 
 
Report Options 
  
Selection of the Options tab shows the various available report option settings (see below) 
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The various report Options control what is included/excluded from the report outputs. By default 
those options that are selected in the “Include” section are included in the report output (red 
box), and those options that are selected in the “Exclude” section are excluded from the report 
output (orange box). For example, the report output for the above settings would include: text 
PIs, My Location (the location associated with your login), Item No., Details (names of Library 
locations returned by the report), Summary data (including: Total, Average, Median); and the 
report would exclude: null entries, 0 Values, and Links (any dynamic linked content usually 
included in the report). 
 
The following is a summary of the report options currently available. 

Option Description 

Include: Check option to include 

Text PIs Check this option to include the text PIs and associated data in the report 
output. If you only want numeric PIs and values included in the report 
output, leave this setting unchecked. 

My Location Check this setting to force the inclusion of your (login) library and 
associated values in the report. 

Collection Owner Check this setting to include the data collection owner’s location and 
associated values in the report, e.g., ACRL is the owner of the ACRL data 
collection, or PLA is the owner of the PLA data collection. 

Percentage Change Check this option in the Trend/PI or Trend report to add the percentage 
change of values between each selected period included in the report. 

Section/Group Name Check this setting to add section/group names to the report.  These 
group/section names are added as headers in the report and show which 
group/section the PI belongs to in the data collection. 

Item No Check this setting to add Item No. prepended to the PI name field. 

Notes Check this setting to add notes (annotations about values included in the 
report) as a footnote to the report. 
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Definitions Check this setting to add definitions for the selected data elements as a 
footnote to the report. 

Details Check this setting to include the location names and values in the reports.  
If any of the Summary options (below) are selected, then unchecking this 
setting will exclude the location names and values from the report but the 
Summary values will still be included for those locations included in the 
scope of the report. 

Summary Check/Uncheck to toggle inclusion/exclusion of Summary data options. 

Total Check this setting to add total values to the report. 

Responses (N) Check this setting to add N - number of responses to the report. 

Avg (Average) Check this setting to add AVG value to the report. 

Max (Maximum) Check this setting to add MAX value to the report. 

Min (Minimum) Check this setting to add MIN value to the report. 

Median Check this setting to show Median value to the report. 

25th Percentile Check this setting to show 25th percentile value to the report. 

75th Percentile Check this setting to show 75th percentile value to the report. 

Exclude: Check option to exclude 

Header Check to hide the header on report 

Null Entries Check to exclude locations with only null values 

0 Values Check to exclude locations with only zero values 

Derivatives Totals / Avgs 
(Averages) 

Check to exclude summary total and average value for the derivative PIs 

Filter Settings Any filters used are displayed by default. Check this entry to exclude from 
the generated output 

Links Disables all links in reports that feature drill-down, download and pop-up 
links. Useful when only printing and/or embedding report outputs. 

 
  
Results Filtering 

 
Any PI added to a Report can be used to filter records. Plus/Minus Percentage (%) filter ranges, 
Minimum and/or Maximum values can be defined. Filter settings ensure that only records with 
values that meet the filter criteria are included in the results. The “% Filter Low >=” field is where 
a percentage range filter can be applied. By setting the “% Filter Low >=” value to 5% for 
example, LibPAS will filter based on the data value for the user’s login location and returns data 
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records within +/-5% of that PI value (e.g., Value = 100,000; Percentage Filter = 5%; Filter 
Range is 95,000 ⋝ X ⋜ 105,000).  
 
It is also possible to filter records based on the text elements (.g., Library name (shown below), 
County, etc.). Hover over the corresponding text box and mouse-click to open the filter settings 
pop-up window. Select (highlight) the listed choices required for your filter. Then, click Update 
when you are done. 
 

 
 
Report Types 
LibPAS offers many different Report Types that give different views of the data. Most tabular 
report types feature graph icons to pop-up graphs for the selected results and downloadable 
Excel files enabling off-line analysis and reporting, and or archiving. 
 
Table Report – The Table report provides a summary view of the data by reporting location for 
a given period. The report features interactive column sorting, pagination options, and graph 
icons linked to ranked bar chart views as well as an Excel download. Results for your location 
are highlighted (a different color is used) in the tabular and graph outputs, for ease of 
identification and comparison. Options include the inclusion of; summary data (e.g., Avg, 
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Median, Max, Min, Total, N), notes, group names, definitions, etc. or the exclusion of; Null 
Entries, 0 Values, Header, etc. 
 

Example Table Report 
 

 
  
Table Report Tips: 

Display more libraries: At the bottom of the report, increase the number of records per 
page  

Sorting: Click on the arrow at the top of any column to sort libraries, i.e. by population size, 
etc. Shift-Hold, Mouse-Click allows data to be sorted by multiple selected columns sorted by 
the sequence of selection and sort direction selected in that sequence. 

Printing: For larger print-outs adjust your "Page Setup" i.e. "Legal" or "Landscape" or 
download the results into Excel and further adjust the format. 

Bar graphs: To enlarge a bar graph click on "Expand" icon. To print or embed bar graphs in 
other documents, right-click on the graph and Save to a local folder or use the copy image 
feature (if available with your browser) to copy-and-paste into another document. 

 
  
 
 
 
 
 
 
 
 

Table Report Features 
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PI Report – PI Reports present the data for each selected PI in a rank ordered table, including 
summary data for the selected PIs (performance indicators) and Period. By default, the output 
includes the Average (mean), Total, Variances and Quartiles for the selected PI(s). As well, 
summary data Options can be added and the sequence and prompts used can be customized 
as desired. 
  

Example PI Report 

 
  
Graph/PI – Displays the values for the PIs in a bar graph sorted by PI value in ascending or 
descending order.  The sort direction is set on the report settings screen by clicking the 
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directional arrow related to each PI selected.  This report type supports the use of overlays as 
shown below. 

  
 

Graph/PI Overlays 
 
The Graph/PI report type provides a setting for an “Overlay” that can be displayed on each 
generated bar graph.  The overlay results appear as a line superimposed on the generated bar 
graph, with the scale for the overlay along the top axis, and the scale for the bar graph along the 
bottom.  This visual “cross-tabulation” can help to visualize the relationship between values of 
two PIs. To create an overlay, simply click in the appropriate Overlay field to get to the pop-up 
screen where you can select the desired PI to overlay. In the example (below) the PI for “Books 
-  Adult & YA” circulation (ADYABOOKCI) has been added as an Overlay to the PI for “Books” 
holdings. 
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Summary – The Summary report compiles a summary view of each PI included in the report for 
the chosen period detailed by the selected summary data options (e.g., Total, Average, Max, 
Min, Median) selected in the Option tab.   The summary values reflect the data returned for 
those libraries included within the scope of the report settings (e.g., as shown below, those 
libraries having a population served +/- 5% of the Population of Legal Service Area reported by 
the Library associated with the user login). 

 
 
Summary Graphs – The Summary graph report (a box and whiskers diagram) presents the 
spread of values recorded by those Libraries within the scope of the report.  The result is a 
comparative picture for the selected PI(s) for the chosen period for the login Library relative to 
the value this Library has reported.  There are markers for the minimum, maximum, and 
average values. The red box represents where 50% of the results fall between the 25th and 
75th percentile. See below. 
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Trend/PI – The Trend/PI report displays the data for the chosen PIs over the selected range of 
periods.   This report also features a click only graph of the data. As shown below, if the scope 
of the report includes more than 8 libraries with data, the graph view is presented as a bar and 
whiskers plot showing the min, average, max values in the range, as well as the 25th to 75th 
percentile range (pink box).  The login library values are then plotted as a trend line to show 
how the login library compares to the range. 
 

 
  
As shown below, if the scope of the report includes less than 8 libraries the graph view is 
presented as a line chart where the login Library location has the thicker line among the others. 
 

 
  
Trend Reports – Trend reports enable comparison of results spanning multiple periods. The 
range can span any number of periods defined by the data collection selected. Trend reports 
support various Options including Details and Summary data: number of respondents (N), the 
Average (mean), Min and Max values, Median and Total values.  
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The Trend report can include different report options, select the Options tab to customize Trend 
reports. The example above shows a variety of Summary data options included.  This report can 
be customized to provide a Summary version that does not include the details of each Library 
location and only shows the Summary data values for the selected range of periods.  This is 
achieved by de-selecting “Details” in the report settings Options tab. Below shows the result of 
this report not including the details. 
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The reports feature pop-up graphs (graph icon). Select the graph icon in any row to view the 
chart for the corresponding row of data, as shown below.  
 

 
 
In the example Trend graph (above) the pink shading in the background represents the average 
value. Above average results are shown by the Blue bars, while below average results are 
shown in red. 
 
Period Comparison – Period comparison reports compare results for two selected periods. 
This Report Type shows values for each Period and the Gap (difference). Various Graph icons 
exist for generating graphs displaying the results of each period and or the differences between 
each period, including Plus/Minus and Comparative bar charts. 
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PI Gap – The PI Gap Report is useful in comparing data from two data elements. The paired 
comparison of PIs in the report output is determined by their Sequence value in the Report 
settings screen (1:2; 3:4; 5:6, etc.). 
 

 
 
The PI Gap Report also features downloadable Excel results, and click-only icons to pop-up 
graphs similar to the Period Comparison report. 
   
Cross Tab – A Cross Tabulation Report compares a range of results for one PI versus another.  
You can generate several cross tab tables in one report.  Each selected PI in the report is 
compared against the first PI (defined by Sequence.)  The Cross Tab Report provides counts 
and percentage values of row and column totals in each cell of the report.  Cross Tab Reports 
also feature links, from the counts, that enable a drill-down to a listing of the corresponding 
locations and their values for the PIs in the Cross-Tab. 
  
To create a Cross Tab Report you will need to create a report and then setup Group breakouts 
for the Cross Tab report, see the image below. 

 
  
Once you click on the Group link you can set the groups you would like to use to breakout the 
data. 
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Custom Format – Custom Format Reports provide you with more customizable options 
including the ability to style the output using Cascading Style Sheets (CSS.) Custom reports 
also provide a unique URL link that can be inserted into any merge document; thus providing 
users with a way to integrate results directly into custom formatted Documents (e.g., Word, 
Excel, etc.). Each time the Document is opened, the most recent data can be fetched from 
LibPAS. This feature is very useful for auto-creation of standard Monthly, Quarterly and Annual 
reports that typically include several Custom Reports throughout the Document. 

 

Custom Format Reports and Merging 
  
Custom reports offer numerous options to control the content, style (using CSS) and 
layout/orientation of LibPAS report outputs.  
  
To create a document that combines data from multiple reports (for example an annual or 
monthly report combining several graphs/charts), you can merge data from more than one 
LibPAS report into Word or Excel document(s) (similar to a traditional mail merge). Using this 
Document Merge functionality, you have the ability to re-use the Document "Template" every 
time you wish to produce the report. Merged documents use the latest data from LibPAS. 
  
To create a custom merge report, the Custom Format report type is selected and options are set 
in the Report Settings, Options, Option Settings and Format tabs for the report.  These settings 
determine the content included in the report, including: prompts (titles, report name/description, 
period labels); range and the scope of the information to presented (number of data points); 
optional inclusion/exclusion of information and report parts (e.g., column and/or row headers); 
report orientation  (e.g., Column: PIs  X  Row: Locations or Columns: Locations X Rows: PIs); 
addition of Column and/ or Row totals; as well as desired formatting of the content. 
  
While it is easy to create, layout and format the Custom Format reports online and view the 
outputs of this report, the need to merge the formatted output in the appropriate offline 
document must be considered as part of the report design at some point to achieve the desired 
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final results, especially when printing is the ultimate requirement.  Consideration must be given 
to the final output media including: page size; margins; page text area; alignment/justification; 
paragraph and line spacing, headings, fonts, column widths, row heights, boarders, cell 
padding, etc.) In most cases the desired formatting can be achieved using CSS in the Format 
tab, however there are times when formatting may be handled best in the word processing 
document itself, e.g., Word. 
 

 
  
The preceding graphic shows the typical layout of the Custom Format table report output with 
prompts related to the output options and a suggestion of how this report might fit within a 
typical document page.  Many of the LibPAS reports, and the Custom Format report, support 
multiple columns and rows of data, however for a table to be sized appropriately and the content 
to be legible, consideration will need to be given to the limitations of the target document. 
  

To produce your report: 
Create a New Report or Select any one of your existing reports. 
 
Note:  Some consideration will have to be given to the content of the report output prior to 
merging with Word or Excel due to the possible constraints of the final desired output, such as 
printed pages. 
  
The Report type for the report should be set to “Custom Format” Report. 
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The following instructions are based upon the Programs by Age Group report from the Alachua 
County Library District (Public Library), which they have given us permission to share.  The 
Report Settings for this Custom Format report are shown below. 
 

 
 
In the Report Settings notice that the Custom Format has been selected for the Report (red 
arrow), and … 
1.       The Options included are as follows: Current Month, Current YTD (Year-to-date), Prior 
Month (i.e., same month prior year), and Prior YTD (i.e., year to date for the same range of 
months, but for the prior year). 
2.       The Prompts (i.e. Labels) related to these options have been assigned.  Note: If for 
example the report Period is changed to September 2011, then the Current Month prompt 
should be changed to September as well as Prior Month prompt should be changed to 
September. 
3.       A Title for this report has been given.  This title will automatically be added to the report 
table in the header row. 
  
Other options have been applied to this report. 
  
In the report Options tab, include Total has been checked, as well, exclude Null Entries and 0 
Values has been checked. 
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This means that the report will add a row to the table report which totals the data in each column 
and if a library that has no data (null values) or input zeros for all variables, this library will be 
excluded from the report output. 
  

  
  
As well in the Options Settings tab, a Title for the Column Total has been set, Total and the 
orientation of the table has been set to show each location (library name) listed in the first 
column (i.e. row headers) and the PI names to be  listed in the Column headers. 
  
Note: If in the Options tab you have not selected Total in the Summary data options, you can 
simply add the prompt Total to the Row Total field in the Option Settings tab and this will have 
the same effect to add a Total row to the report table. 

Formatting the report 
  
LibPAS enables users to format report outputs using CSS.  In the Format tab of the Report 
Settings screen as user can modify the CSS codes to change any of the formatting in the report 
output.  Table and column widths can be set.  Font sizes and colors can be altered including cell 
background colors.  Or borders can be added and removed. 
  
If you are unfamiliar with CSS there are a number of tutorials and instructional resources 
available online.  Otherwise you might consult with a staff member in your Library system that 
has experience with CSS codes. 
  
The CSS formatting codes for the Programs by Age Group report (below) are provided at the 
end of this document for your reference. 

Running the Report 
  
After you run the Custom format report you will find there is a URL provided immediately below 
the Report Table.  This URL can be embedded and merged with an MSWord document, as 
shown on the following page, or similarly in an Excel document using the Get External Data 
function From Web. 

Merging a LibPAS report with MS Word 2007/2010 
Step 1 
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Open the document in which you want to merge your report (i.e., insert a field). Or you can open 
a new, blank document and start from scratch. Click on the space where you want your field, so 
that your cursor is right in the spot where you want your inserted field to appear. 
  
Step 2 
Click Insert on the toolbar, then click Quick Parts, and then click Field. The Field dialog box will 
open. On the left-hand side of the dialog, you will notice that under Please Choose a Field there 
is a Categories drop down. Choose Links and References from the drop-down menu.   
  
Step 3 
Click on IncludeText in the Field Names box. In the Field Properties section, insert your cursor 
in the Filename or URL field and type or paste the URL provided by LibPAS for the report. 
  
For example, the report URL might be  - 
http://www.countingopinions.com/pireports/report.php?rkey=9d58cd8dc7144bb53391af3ef2282
0b5&rid=2464 
  
Note: This is an active report URL and will work if merged in a Test document. 
  
Step 4 
Uncheck the Preserve formatting during updates check box.  This means that the online source 
formatting will take precedence over any internal Word document formatting.  Leaving this 
option checked can cause some unpredictable formatting issues. 
  
Step 5 
Click OK when you have chosen the field you want to insert and any properties or options. Save 
the changes to your document, so that the next time the document is used the fields will be 
available. 

Here are the detailed steps in Word 
  
In the ribbon, under the Insert tab you will find the tool called Quick Parts among the Text group.  
Click on Quick Parts allowing the list of option to expand, and then select Field… as shown 
(below). 
 

  
  
  

http://www.countingopinions.com/pireports/report.php?rkey=9d58cd8dc7144bb53391af3ef22820b5&rid=2464
http://www.countingopinions.com/pireports/report.php?rkey=9d58cd8dc7144bb53391af3ef22820b5&rid=2464
http://www.countingopinions.com/pireports/report.php?rkey=9d58cd8dc7144bb53391af3ef22820b5&rid=2464
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This will open a dialog window called Field.  In this dialog window, navigate and select Links 
and References from the Categories list (as shown below). 

 
  
After you select Links and References the dialog will automatically refresh to display a list of 
Field names related to Links and References. 
  
Step 1 - In the Field names 
list, select the field name 
IncludeText. Again the dialog 
refreshes.  Field properties is 
now shown and an empty 
field for Filename or URL: is 
presented.  
  
Step 2 - Please copy and 
paste in this field the entire 
report URL found in the 
output view of the Custom 
Report. 
For example, 

http://www.countingopinions.com/pireports/report.php?rkey=9d58cd8dc7144bb53391af3ef2282
0b5&rid=2464 
  
Step 3 – Uncheck Preserve formatting during updates.  This allows the formatting created 
online in the Format tab of the report to take precedence over the Word document formatting. 
  

Merging a LibPAS report with MS Word 2003 
Please refer to the following MS Office online help – 
http://office.microsoft.com/en-us/word-help/insert-a-field-HP005189388.aspx 
  

Update the Report 
  
If you have already embedded a Custom Report, click on a cell in the report table in your 
document.  This will highlight the entire report table.  You can either press ‘Function 9’(F9) on 

http://www.countingopinions.com/pireports/report.php?rkey=9d58cd8dc7144bb53391af3ef22820b5&rid=2464
http://www.countingopinions.com/pireports/report.php?rkey=9d58cd8dc7144bb53391af3ef22820b5&rid=2464
http://www.countingopinions.com/pireports/report.php?rkey=9d58cd8dc7144bb53391af3ef22820b5&rid=2464
http://office.microsoft.com/en-us/word-help/insert-a-field-HP005189388.aspx
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your keyboard, or click your right mouse button while still in the table, which 
will offer a menu of options, then click Update field as shown to the right.   
After pressing F9 or clicking update field, if you have updated the report 
settings online and saved these settings,  you should see the report table 
automatically update in your Word document. 
  
Note PC Users -- You can update an entire document of embedded 
tables by performing  the following keyboard shortcuts – CTRL-A then 
press  F9 on your keyboard. 
  
Below is a representation of what the Custom Report would look like 
merged with a Word document.  (Google Docs does not currently support this feature). 

 
  
*Shared with permission from Alachua County Library District. 
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Merging a LibPAS report with MS Excel 2007/2010 
  

Create a new Web query  
  
Step 1  
In Microsoft Office Excel, on the Data tab, in the Get External Data group, click From Web. 
In the browser, browse to the Web page from which you want to query the data, right-click the 
Web page, and then click Export to Microsoft Excel on the shortcut menu. 
  
The New Web Query dialog box appears. 
  
Step 2   
In the New Web Query dialog box, enter the URL for the Custom Report page from which you 
want to get data. You can type the URL or paste it from a copied address. 
  
Step 3 
Click the  button next to the tables that you want to import, or click the  button in the upper-
left corner of the page to import the entire page. 
  
Tip - If there are no  buttons next to the tables on the page, click Show Icons  at the top of 
the dialog box to display them. 
  

Formatting Options 
To set the formatting and import options for how data is returned, click Options, and then do one 
or more of the following in the Web Query Options dialog box: 
  
Under Formatting, click one of the following: 
  
None 
This option returns none of the formatting on the Web page that you are querying, only text. 
Formatting that exists on the Excel worksheet is applied. 
  
Note: This is ideal for a merge of “raw data” 
  
Rich text formatting only  
This option returns the type of formatting that  Excel can reproduce most closely, such as font 
styles. It does not include HTML formatting, such as hyperlink formatting. 
  
Note: This is ideal for importing the online formatting you have added to the Formats tab 
of the Custom Report. 
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Full HTML formatting    
This option returns all HTML formatting that Excel supports, such as hyperlink formatting. 
  
Note: This option clears the Preserve cell formatting check box in the External Data 
Range Properties dialog box. 
  
Click for more instructions from Microsoft Office. 

Appendix A: Programs by Age Group - CSS Codes 
  
body { 
     width: 100%; 
             font-family: verdana, arial, helvetica, sans-serif; 
             font-size: 9pt; 
             background-color: #ffffff; 
             margin: 0; 
             padding: 0; 
} 
legend { 
             font-size: 9pt; 
             font-weight:bold; 
             color: #0577B4; 
} 
.main { 
             background-color: #fff; 
             font-family: verdana, arial, helvetica, sans-serif; 
             color:#000; 
             font-size:9pt; 
} 
.rperiod { 
             background-color:#fff; 
             font-family:Bodoni MT Black,sans-serif; 
             color:#000; 
             font-size:14pt; 
             text-align:center; 
             font-weight:bold; 
             text-transform:uppercase; 
} 
table.tblreport { 
             width: 7in; 
             background-color: rgb(240,240,270); 
             font-family: verdana, arial, helvetica, sans-serif; 
             color:#000; 
             font-size:9pt; 

http://office.microsoft.com/en-us/excel-help/get-external-data-from-a-web-page-HA010218472.aspx?CTT=1
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              font-variant: small-caps; 
} 
.tbltitle { 
             font-weight:bold; 
              font-size:16pt; 
              font-variant: small-caps; 
             text-align:left; 
} 
.tblreportname { 
               font-weight:bold; 
               font-size: 14pt; 
               text-align:left; 
             border-bottom:1.5pt black solid; 
} 
.tbldescription { 
             text-align:right; 
} 
.tblperiod, .tblperiod1 { 
             font-weight:bold; 
             text-align:right; 
} 
.tblperiod2 { 
             font-weight:bold; 
             text-align:center; 
             border-bottom:1.5pt black solid; 
} 
.tblperiod3 { 
             font-weight:bold; 
             text-align:center; 
} 
.tblpiname, .tblpiname1, .tblpiname2, .tblpiname3 { 
             text-align:right; 
              border-left: thin black solid; 
} 
.tblcolumn1 { 
             text-align:left; 
} 
.tbldata { 
             text-align:right; 
              border-left: thin black solid; 
              border-top: thin black solid; 
             background-color: rgb(250,250,170); 
} 
.tbltotal { 
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             text-align:left; 
              font-weight: bold; 
} 
.tbltotals { 
             text-align:right; 
              font-weight: bold; 
} 
tr.tbltotalrow td { 
             border-top:thin black solid; 
} 
 
Published Reports – All reports can be published and shared with others by sending via email, text 
message, twitter or posting on a website or blog. You can also use the QR-Code feature to post links to 
reports in print materials. Users are not required to login to see the results and can use all the 
interactive features supported in the reports (e.g., downloads, pop-up graphs, drill-downs) 

 
 

 
  
For more information and instruction on how to use the LibPAS reporting tools, please refer to 
the online “Help” linked from the top right corner of most screens. 



   

For the Confidential and Exclusive use of Counting Opinions Subscribers 
Page 33 of 33 

 

  
If you have any questions regarding the setup and function of the LibPAS reports, please 
contact support@countingopinions.com. 
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